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BIMx Inleiding



• BIMx - VS - BIMx Hyper Model  

• De software:  

• BIMx Desktop Viewer 

• BIMx application (Tablet/Smartphone)  

• BIMx PRO application (Tablet/Smartphone) 

• Prijzen

Inleiding 

Overzicht BIMx
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BIMx is een export vanuit ARCHICAD die het 3D model bevat.  

Het volledige gebouwmodel kan bekeken worden met een extern (gratis) programma op desktop, tablet of smartphone.  

Dit model kan doorgegeven worden aan andere partijen.  

Mogelijkheden:  

• Het model bekijken  

• In het model navigeren  

• Snedes maken  

• Modelinformatie bekijken 

Wat is BIMx?  

BIMx
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Een BIMx Hyper Model is een export vanuit ARCHICAD die het 3D model EN de lay-outs bevat.  
De layouts kunnen afzonderlijk worden bekeken en zorgen voor een totaal beeld van het project dat door externe kan bekeken worden.  

Voor het openen van een BIMx Hyper Model is een tablet of smartphone nodig.  

Mogelijkheden:  

• Het model bekijken  

• In het model navigeren  

• Snedes maken  

• Modelinformatie bekijken  
+ 

• Lay-outs bekijken met koppeling naar het 3D model 

• Extra info toevoegen aan het model  

• Andere functionaliteiten in de applicatie. 

Wat is BIMx?  

BIMx Hyper Model
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Navigeren in het ARCHICAD 3D model met een gratis viewer.  

Mogenlijkheden:  

• Wandelmodus met zwaartekracht 

• lagen controleren 

• fly-modus 

• herkennen van doorgangen (deuren)  

• opgeslagen ‘walkthrough’ 

• Informatie van de elementen bekijken 

Tip! 
Sinds ARCHICAD 17 wordt de  
BIMx Viewer automatisch  
geïnstalleerd bij ARCHICAD.  

Zonder ARCHICAD is de BIMx viewer  
GRATIS te downloaded op de Graphisoft website.  

Desktop software 

Graphisoft BIMx viewer - FREE
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Viewer

download : http://www.graphisoft.com/downloads/bimx/bimx_desktop.html 

http://www.graphisoft.com/downloads/bimx/bimx_desktop.html


Applications voor tablet of smartphone 

BIMx - BIMx PRO news
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Ipad pro - promofilm 

http://www.apple.com/ipad-pro/#watch-the-film


Applications 

BIMx - BIMx PRO
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€€



Applications 

BIMx - BIMx PRO
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Applications 

BIMx - BIMx PRO
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Extra informatie  

BIMx Hyper Model ONBEPERKT delen met iemand die geen BIMx PRO heeft : Sharing
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BIMx voorbereiding ARCHICAD 



BIMx is een export vanuit ARCHICAD die het 3D model bevat.  

Het volledige gebouwmodel kan bekeken worden met een extern (gratis) programma op desktop, tablet of smartphone.  

Dit model kan doorgegeven worden aan andere partijen.  

Mogelijkheden:  

• Het model bekijken  

• In het model navigeren  

• Snedes maken  

• Modelinformatie bekijken 

Wat is het?  

BIMx
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In een BIMx wordt enkel het 3D model opgeslagen. 
Het beeld wordt opgeslagen met dezelfde instellingen die actief zijn in het geopende 3D venster.  

Instellingen standaard 3D 
• Ga naar het 3D venster (F4/F5) .  

• De instellingen die van belang zijn bij de export zijn: 

• Layer combination 

• Partial structure display 
• Renovation filter 

• Maak een nieuwe view voor de BIMx export.  

Opslaan als BIMx 
• Open het gewenste 3D venster 

• Ga naar file > save as… 

• Kies als formaat ‘BIMx’ 

• Sla de file op

ARCHICAD model optimaliseren voor BIMx 

Inhoud van het model
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Bij een BIMx kunnen ook vaste camerastandpunten toegevoegd worden.  Het is ook mogelijk om een export te maken waarbij enkel deze 
camerastandpunten gekozen kunnen worden om het model te bekijken.  

Instellingen camerastandpunten 

• Plaats enkele camera’s in het model op het grondplan met de camera tool 

• Stel de camera’s correct in: 
1. De kijkhoogte 

2. De afstand tot het model 

3. De openingshoek 

4. De hoogte en positie van de zon als deze anders moet zijn dan de default  
instellingen van het project. (View > 3D View options > 3D Projection settings… ) 

ARCHICAD model optimaliseren voor BIMx 

Vaste camerastandpunten toevoegen
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Camerastandpunten opslaan als view (niet noodzakelijk) 
• Voeg de camerastandpunten toe als views.  

Dit kan via een clone of via de organizer.  

Let op!  
Bij een clone zullen alle nieuwe camera’s ook steeds mee in de map terecht komen. 

Let op!  
Als de camera’s andere viewinstellingen hebben worden  
deze niet opgeslagen in de BIMx. Enkel de ‘camerastandpunten’. 

ARCHICAD model optimaliseren voor BIMx 

Vaste camerastandpunten toevoegen
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Opslaan als BIMx 
• Open het 3D beeld met de een camera uit het path. 

• Ga naar File > Save as…  

• Kies voor BIMx formaat 

• Vink ‘Start BIMx after save’ aan.  
Kies er dus voor om BIMx desktop op te starten  
na het exporteren en direct een controle uit  
te voeren.  

Klik op options voor de BIMx Export Options: 
1. Voeg de camerastandpunten toe als aparte  

beelden die geopend kunnen worden om snel  
te navigeren.  
De camera’s kunnen vanuit de galerij geopend  
worden.  

2. Maak van de camerastandpunten een navigatie- 
filmpje dat afgespeeld wordt vanuit de galerij.  

3. Limiteer de navigatie tot enkel de camera’s uit 
de galerij. Bij het openen van zo een camera kan  
er wel nog steeds rondgekeken worden vanaf  
de plek van de camera. 

ARCHICAD model optimaliseren voor BIMx 

Vaste camerastandpunten toevoegen
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Wanneer BIMx desktop opent ben je direct aan het  
navigeren door het model.  

• Klik ‘ESC’ om in het menu te komen 

• Ga naar Gallery 

• Dubbelklik op de preview  

• Kies voor ‘next’ om het volgende  
camerastandpunt in de preview te zien. 
 

• Bij een film zal na een dubbelklik op de 
preview de film beginnen afspelen.

ARCHICAD model optimaliseren voor BIMx 

Vaste camerastandpunten / film op BIMx desktop
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In de BIMx application zijn de camerastandpunten direct beschikbaar.  

ARCHICAD model optimaliseren voor BIMx 

Vaste camerastandpunten / film BIMx application
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Let op!  
Er kan wel rondgekeken worden vanuit de standpunten van de camera’s maar  
het is niet mogelijk verder te navigeren.



BIMx Hyper Model 
voorbereiding ARCHICAD 



Een BIMx Hyper Model is een export vanuit ARCHICAD die het 3D model EN de lay-outs bevat.  
De layouts kunnen afzonderlijk worden bekeken en zorgen voor een totaal beeld van het project dat door externe kan bekeken worden.  

Voor het openen van een BIMx Hyper Model is een tablet of smartphone nodig.  
(De BIMx desktop viewer kan enkel de 3D beelden van het BIMx Hypermodel openen)  

Mogelijkheden:  

• Het model bekijken  

• In het model navigeren  

• Snedes maken  

• Modelinformatie bekijken  
+ 

• Lay-outs bekijken met koppeling naar het 3D model 

• Extra info toevoegen aan het model  

• Andere functionaliteiten in de applicatie. 

Wat is het?  

BIMx Hyper Model
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De informatie van een BIMx Hyper Model 

wordt verzameld in een Publisher set 

• 3D modellen (meerdere!) 

• Layout’s met 2D plannen + informatie  

• Layout’s met extra informatie 

Andere informatie die gebruikt wordt bij het 

maken van een BIMx Hyper Model  

• Preview beeld 

• BIMx Schedule

Wat is het?  

Inhoud van een BIMx Hyper Model
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Map aanmaken in de view-map.  
• Maak een nieuwe map aan waar alle 3D informatie voor het BIMx Hyper Model verzameld en ingesteld kan worden. 

ARCHICAD model optimaliseren voor BIMx Hyper Model export 

Overzicht in de navigator
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De zichtbare inhoud van het 3D venster zal worden opgeslagen in de BIMx Hyper Model.  

Bij het opslaan kan ook gekozen worden om meerder 3D ‘modellen’ op te slaan.  

• Maak views aan met de juiste instellingen van het 3D beeld 

 Er kan zo een view gemaakt worden van bv:  

• Het presentatiemodel 

• Het structurele model  

• Het IFC model (HVAC, MEP,…)  

• De zone’s* 

• De verschillende renovatiefilter opties 

• … 

* maak de zone’s in ARCHICAD zichtbaar in 3D bij View > Elements in 3D view > Filter and Cut elementen in 3D… 

Zones worden altijd mee geëxporteerd in een BIMx, ook als ze niet zichtbaar zijn. Ze kunnen in de app ook on-/zichtbaar gemaakt worden bij 
de settings. 

ARCHICAD model optimaliseren voor BIMx Hyper Model export 

Het 3D model - views
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Wanneer een plan wordt bekeken in BIMx wordt er naar de plek ingezoomd om de informatie duidelijk te krijgen.  

Probleem : we verliezen het overzicht  
Om duidelijkheid te scheppen over wat dat de informatie gaat kan er  
gebruik gemaakt worden van een kleurcodering.  

• Gebruik voor de snedelijnen  een andere pennummer dan de  
grid elementen.  

• Geef de hoogtepeilen, maatlijnen een eigen kleur.  

• … 

Door een aparte kleurcodering (penset) te gebruiken blijft het 
steeds duidelijk naar welke informatie je kijkt bij het inzoomen.  

De penset ‘Basis kleur’ kan hiervoor gebruikt worden.  
De eerste 10 pennen kunnen allen omgezet worden naar zwarte pennen  
voor een andere export dan BIMx, door eenvoudig een andere penset te  
activeren. (basis zwart)  

Tip:  
Stel in de template de defaults van de gereedschappen in zodat 
ze standaard de juiste pen kiezen. Of maak hier een favoriet voor  
aan.  

ARCHICAD model optimaliseren voor BIMx Hyper Model export 

2D documenten - werkmethodiek : Penset
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Voeg alle plannen toe aan het BIMx Hyper Model door ze op layout’s te plaatsen.  
Maak hiervoor eventueel gebruik van een Master die geoptimaliseerd is voor BIMx Hyper Model export.  

Let op de volgende punten bij het maken van een Master: 

• Een kleinere titelhoek is nog steeds duidelijk, er kan naar gezoomd worden.  

• De grootte van de master hoeft geen plotmaat te zijn maar kan aangepast worden aan het model.  

Let op de volgende punten bij het maken van de Layouts: 
• Zet de layout’s in een subset zodat ze duidelijk gesorteerd zijn 

• Zorg dat de markers steeds zichtbaar zijn op de plannen. Hierdoor kan er makkelijk tussen de plannen gewisseld  
worden door een marker te activeren. vb: snedelijn, gevellijn, …  

• Voeg ALLE informatie toe die op de werf nuttig kan zijn.  
Hoe duidelijker de informatie, hoe minder vragen, hoe minder fouten. 

ARCHICAD model optimaliseren voor BIMx Hyper Model export 

2D documenten - Master en Layouts
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Voeg steeds alle beschikbare nuttige 

informatie toe.  

• Maak een layout voor het interieur van de 
ruimtes om het sanitair te zien.  

• Maak gebruik van de ‘interior elevation- tool’ 
om interieurzichten te maken zodat deze 
gekoppeld kunnen worden.  

• Voeg een schedule toe waar informatie op te 

vinden is van de objecten die zich in de ruimte 
bevinden.  
 

 

ARCHICAD model optimaliseren voor BIMx Hyper Model export 

2D documenten - Inrichting (sanitair)
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Zet alle informatie op een layout die beschikbaar moet zijn op de werf.  
• Ingenieursplannen  

• Foto’s van de Bouwaanvraag 

• Renderingen 

• Werfverslagen 

• … 

Alle informatie is nu binnen handbereik!

ARCHICAD model optimaliseren voor BIMx Hyper Model export 

2D documenten - Andere nuttige documenten toevoegen
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Bij een BIMx Hyper Model kan ook extra informatie toegevoegd  
worden aan de elementen.  

Deze informatie wordt zichtbaar als je op de  
tablet of smartphone  op de elementen klikt en  
kiest om de ‘info’ weer te geven.  

ARCHICAD model optimaliseren voor BIMx Hyper Model export 

Informatie toevoegen aan de elementen
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Standaard informatie voor de BIMx Hyper Model elementen komt uit het BIMx schedule:  
De informatie wordt toegevoegd met behulp van een standaard schedule:  

In dit schedule worden alle elementen opgesomd met de beschikbare informatie erbij. Niet alle velden zijn ingevuld. De lege velden worden 
ook niet weergegeven in het informatievenster in de app. 

ARCHICAD model optimaliseren voor BIMx Hyper Model export 

Schedules met extra info 
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Toevoegen van eigen extra informatie  

• Open de Scheme settings van het schedule ‘Standaard BIMx Schedule’ 

• Kies bij Fields voor ‘Add…’ 

• Voeg ‘Custom text 1’ of meerdere custom texts toe. 

• Vul eigen tekst in bij het schedule per element  

Tip! 

Voeg hier een link naar een wegpagina toe.  

• Deze tekst is dan beschikbaar als link in de BIMx (PRO) app. 

ARCHICAD model optimaliseren voor BIMx Hyper Model export 

Schedules met extra info 
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Een preview voor een BIMx Hyper Model maken 
Ga naar File > Info > Project Preview… 

• Een afbeelding naar het klembord kopiëren  

• Bladeren naar een afbeelding  

• Een afbeelding maken van het openstaande werkblad

ARCHICAD model optimaliseren voor BIMx Hyper Model export 

Preview beeld instellen
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Mobiele apparaten hebben minder goede ingebouwde hardware (RAM) dan een desktop of laptop. Hierdoor kan het zijn dat de BIMx (PRO) 
applicatie sluit bij het openen van deze projecten op een mobiel apparaat.  

We kunnen dit verhelpen door het model te optimaliseren binnen ARCHICAD voordat het wordt opgeslagen als BIMx Hyper Model.  

Hoe het model te optimaliseren:  

• Het aanpassen van de grootte van het model  

• Het aanpassen van de kwaliteit van het model

ARCHICAD model optimaliseren voor BIMx Hyper Model export 

Omgaan met grote projecten
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Bekijken de informatie van het model in de BIMx Desktop viewer voordat het naar de app gaat.  
• Open de BIMx Desktop viewer.  

• Klik ‘ESC’ om in het menu te komen 

• Ga naar info  

• Bekijk de informatie over het RAM gebruik van dit project op een mobiel apparaat 

ARCHICAD model optimaliseren voor BIMx Hyper Model export 

De grootte van het model 
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Een model kan groot (aantal mb) worden door het aantal polygonen.  

Oorzaken van veel polygonen:  
• Gekromde vormen 

• Heel gedetailleerde bibliotheekelementen  

• Een heel gedetailleerd terrein  

• Bomen  

• Een layout met te veel polygonen in de Master - Veel layouts zorgen  
dan voor een snelle groei van het aantal polygonen.  

• Een afgeronde morph 

Het aantal polygonen nakijken 
Polygonen kunnen nagekeken worden met behulp van de PolyCount Tool.  
Deze kan je downloaden via de volgende link:  
http://helpcenter.graphisoft.com/tips/polygon-counting-tool/  

Installeer de Add-on en open ARCHICAD.  
Ga naar Window > pellets > PolyCount  

Bepaal van de geplaatste objecten het detailniveau (Set Level of Detail) 

ARCHICAD model optimaliseren voor BIMx Hyper Model export 

De grootte van het model 
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Bij het gebruik van een BIMx Hyper Model kan het model op andere manieren verkleind worden.  

• Opsplitsen van het 3D model 
Sla verschillende 3D modellen op met steeds een andere inhoud, zoals eerder beschreven.  
Hierdoor is alle informatie aanwezig maar kan het beeld gefilterd worden.  

• Gebruik de marquee om een bepaald deel te zien 

• Gebruik de juiste lagencombinaties 

• Sla ‘Global illumination’ (GI) over 
Global illumination berekend het indirecte licht voor het 3D beeld bij het opslaan. Dit kan uitgezet worden.  

• Verberg de onbelangrijke elementen met veel polygonen bij de export 
Gebruik de PolyCount Tool om te bepalen welke de elementen zijn met veel polygonen.  
Verberg deze in het 3D beeld door de laag uit te zetten. 

ARCHICAD model optimaliseren voor BIMx Hyper Model export 

De grootte van het model 
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De texturen optimaliseren  
Texturen worden gebuikt door de surfaces en bepalen hoe het 3D beeld 
er uit ziet.  BIMx maakt gebruikt van de OpenGL engine.  

Het gebruik van foutieve texturen kan het model zeer veel verzwaren.  

Let op de volgende punten bij het gebruik van texturen:  

• Gebruik dezelfde texturen bij gelijkaardige surfaces 

• Indien elementen niet zichtbaar zijn, geef ze dan ook geen 
textuur. (of zet er met de Surface painter een eenvoudigere 
textuur op)  

• Doe hetzelfde als de elementen te groot zijn en de textuur toch 

niet duidelijk is door de grootte van het element.  

• Werk met zo klein mogelijke textuur afbeelding. (werk de 
texturen eventueel bij in fotobewerkingsprogramma’s zodat ze 
kleiner zijn) 

ARCHICAD model optimaliseren voor BIMx Hyper Model export 

De grootte van het model 
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Kijk steeds het 3D model in ARCHICAD na voordat de export gemaakt wordt.  
Gebruik hiervoor de OpenGL engine (standaar 3D beeld).  

Zoek naar fouten:  

• Zoek naar missing of foutieve texturen.  
Kijk hiervoor ook in de Library manager,  
File > Libraries & objects > Library manager. 

• Te donkere of the lichte texturen en materialen 

• Overlappende elementen, de texturen gaan dan flikkeren tijdens het navigeren 

• Kamers die niet bereikbaar zijn door het ontbreken van deuren of elementen die 
de doorgang blokkeren.  

• Onnodige elementen in het model die aan staan maar niet zichtbaar zijn. bv, 
leidingen achter het vals plafond. 

• Foutieve aansluitingen van elementen.  (wanden, balken, vloeren, ed.)  

Tip: 

Bekijk het model in 3D walk-trough modus om door het model te wandelen.  
De elementen die foutief zijn zullen beter opvallen. 

ARCHICAD model optimaliseren voor BIMx Hyper Model export 

De kwaliteit van de BIMx (Hyper Model) export
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BIMx Hyper Model publiceren



Er zijn 2 verschillende manieren om een BIMx Hyper Model export te maken.  
Via het menu File > Publish BIMx Hyper-model… OF via de publisher set.  

We raden aan om steeds de Publisher te gebruiken omdat dan alle inhoud dan opgeslagen kan 
worden en er bij wijzigingen in het model eenvoudig een nieuwe publish gemaakt kan worden.  

Tip:  

Maak steeds een aparte pubisher set aan voor de volledige BIMx Hyper Model export.  

Inhoud van de Publisher set 
• 3D modellen  

• Layouts met plannen  

• Layouts met renderafbeeldingen  

• Layouts met extra plannen, vb Ingenieursplannen 

Let op! 
Om een BIMx Hyper Model te maken moet je beschikken over ARCHICAD 17 of later. 

BIMx Hyper Model exporteren  

Publisher set
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Bepaal de ‘publishing proporties’ van de publisher set.  
• Ga naar het hoogste niveau in de publisher 

• Kies de juiste publisher set 

• Kies de Publishing Proporties … 

Opslaan via de Publisher 
• Klik op Publishing Proporties en kies ‘Save files’ (1)  

Vink ‘Create single file’ aan. (2) 

• Vul de gewenste gegevens in. (3) 

• Kies de juiste schedule om de gegevens van de elementen aan te vullen.  
Als hier geen gemaakt is moet er NONE gekozen worden! (4) 

• Kies als formaat ‘BIMx Hyper-Model’ (5) 

• Klik op OK 

Tip: 

Bij Options kan bij de 3D views gekozen worden voor  
‘Generate global illumination for realistic shading’ voor een realistischere 
weergave van het BIMx Hyper-Model. Hierbij zal de rendertijd wel verlengen  
en het model groter worden.

BIMx Hyper Model exporteren  

Publisher set - lokaal opslaan
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Bij het gebruik van BIMx is er de mogelijkheid de bestanden online te delen via een online cloud systeem: BIMx Model Transfer Site. 
Hiervoor is een Graphisoft ID nodig.  

Let op!  
Dit is niet gelijk aan de login die gebruikt wordt op de website van KUBUS om in te loggen bij support.  

Let op!  
Gebruikers die al in een vorige versie van ARCHICAD  
(voor ARCHICAD 17) een account hebben aangemaakt  
moeten dit omzetten. 
Lees hiervoor T&T 078: Registreren of upgraden voor  
BIMx Model Transfer Site.  

https://graphisoftid.graphisoft.com 
Hier kan je het Graphisoft ID aanmaken en beheren.  

Let op! 
Het account waarmee voor het eerst wordt ingelogd in  
BIMx wordt gekenmerkt als bedrijfsaccount waarbij  
eventuele andere collega ś worden aangesloten.  
Dit kan later eventueel worden omgezet naar op een  
ander account. 

 

BIMx Hyper Model exporteren  

BIMx Model Transfer Site
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Waarvoor wordt het Graphisoft ID Gebruikt? 

1. Software licenties downloaden en uploaden 
License Manager Tool  

2. Licenties beheren 
https://graphisoftid.graphisoft.com  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Oudere versie van ARCHICAD downloaden 
https://myarchicad.com  

4. Inloggen op BIMx Model Transfer Site  
https://bimx.graphisoft.com  

5. Inloggen op BIMcomponents 
https://bimcomponents.com 

Graphisoft ID 

Inloggegevens
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https://bimx.graphisoft.com
https://bimcomponents.com


Via de BIMx Model Transfer Site zijn de modellen overal waar een internet connectie is, beschikbaar.  
Met de BIMx , BIMx PRO app’s kan er ook worden ingelogd op de BIMx Model Transfer Site om zo de modellen te downloaden.  

https://bimx.graphisoft.com  

Tip:  
Werk met een duidelijke  
mappenstructuur. Deze komt  
ook terug in ARCHICAD als 
een model wordt geuploaded.  

Let op! 
‘My models’ bevat alle modellen die zijn geüploaded vanaf een Trial of studenten versie. 
‘My Company’ bevat alle modellen die zijn geüploaded van een ARCHICAD geopend met de licentiesleutel van het bedrijf. 

BIMx Hyper Model exporteren  

BIMx Model Transfer Site
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Wanneer er gekozen wordt voor ‘Upload BIMx Hyper-Model’, zal ARCHICAD automatisch 
proberen in te loggen met een GRAPHISOFT ID. Wanneer er nog niet eerder is ingelogd 

kan het ID ingesteld of aangemaakt worden door op ‘Sign in...’ te klikken. 

Tip:  
Lees ook: Tip & Trucs 078: Registreren of Upgraden BIMx Model Transfer site. 

Uploaden via de Publisher 

• Maak een keuze uit de instellingen ‘Public Domein’ of ‘Private folder’ en beveilig 
het project eventueel met een wachtwoord. (1) 

• Kies de map op de BIMx Model Transfer Site waar het project in komt te staan. (2) 

• Vul de projectgegevens in en kies indien gewenst voor het opslaan van een 
plaatselijk kopie. (3) 

• Kies de juiste schedule om de gegevens van de elementen aan te vullen.  
Als hier geen gemaakt is moet er NONE gekozen worden! (4) 

• Klik op OK (5) 

• Na het instellen kan er in de Organizer – Publisher gekozen worden voor ‘Publish’. 

BIMx Hyper Model exporteren  

Publisher set - uploaden naar de  
BIMx Model Transfer site
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Modellen kunnen vanuit BIMx naar de BIMx Model Transfer Site geladen worden. 

• Open het BIMx model. 

• Open het BIMx menu door in het programma op de ESC toets te drukken 

• Kies vervolgens onder File voor Share BIMx Model 

• Controle van het Graphisoft ID bij de BIMx Model Transfer Site. 

• Geef een naam en een beschrijving aan het project. Kies voor de publieke of private map en koppel een afbeelding aan het project. 
Sommige opties zijn  
afhankelijk van het soort licentie: 

• Share 

Modellen delen 

Uploaden vanuit BIMx desktop naar BIMx Transfer Site
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BIMx Hyper Model delen - share



Een BIMx (Hyper Model) kan je steeds opslaan vanuit ARCHICAD en delen via de standaard platformen.  

Enkele standaard platformen

Modellen delen  

Platformen
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BIMx Model Transfer Site 

https://bimx.graphisoft.com 

Modellen delen 

Platform vanuit ARCHICAD : Upload to BIMx Model Transfer site
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https://bimx.graphisoft.com


Modellen delen 

BIMx Hyper Model delen : Sharing
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Het delen van een BIMx Hyper Model kan enkel vanuit de BIMx PRO app.  
De deling kan aangekocht worden per project. (alle volgende updates van het project zijn inclusief)  
Het gedeelde project kan dan gelezen worden in alle app’s met al zijn Hyper Model functionaliteit . Zowel BIMx als BIMx PRO applicaties. 



1. Upload het model naar de BIMx Model Transfer Site vanuit ARCHICAD.  
Gebruik de publisher om het project te uploaden (exporteren) zoals eerder beschreven.  

2. Open de BIMx PRO app op tablet of smartphone en maak connectie met de BIMx Model Transfer Site 
Download het project. 

Modellen delen 

Stappenplan - share a project
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3. Deel het project vanuit de BIMx PRO app.  
Kies voor meer opties in het project en kies hier  
‘Share this project’.  

Je ontvangt nu een email met een activatiecode die  
doorgestuurd kan worden naar een onbeperkt aantal  
personen.  

Modellen delen 

Stappenplan - share a project
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4. Deel het project met anderen 
Een voorbeeld mail zal open om te delen.  
Deze kan doorgestuurd worden naar andere personen. 

Modellen delen 

Stappenplan - share a project
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Bij een aanpassing in het model: 
• Ga terug naar de eerder gemaakte Publisher set in 

ARCHICAD  

• Kies voor publish 

• Op de tablet is er te zien dat er een update beschikbaar is.  

Let op! 
Er moet wel een internetverbinding zijn om de update  
te detecteren en te doen. 

Modellen updaten 

Opnieuw publishen
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BIMx gebruiken



Recommended Operating Systems 
 • Windows 10 (64-bit version) 
 • Windows 8.1 (32-bit and 64-bit) 

 • Windows 8 (32-bit and 64-bit) 
 • Windows 7 (32-bit and 64-bit) 
 • Mac OS X 10.10 Yosemite 
 • Mac OS X 10.9 Mavericks 

Notes on older systems 
 • Mac OS X 10.8 Mountain Lion is compatible but not tested by GRAPHISOFT 
 • Mac OS X 10.6 Snow Leopard and Mac OS X 10.7 Lion are not compatible 
 • Windows Vista is not compatible (BIMx cannot be installed) 
 • Windows XP is not compatible (BIMx cannot be installed)

Systeemeisen 

BIMx Desktop viewer
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BIMx on iOS 
Supported iOS versions 
 • 7.0 and higher 

Supported devices 
 • iPhone 4S and newer 
 • iPad 2 and newer 
 • iPod Touch 5th generation 

BIMx on Android 
Supported Android versions 
 • 4.0 and higher 
Supported hardware 
 • Processor: 1 GHz required, 1.5 GHz dual or quad core recommended 

 • RAM: 1 GB is required, 2 GB or more is recommended 
 • GPU: Tegra3, Mali602, PowerVR SGX 543, Adreno 302 or faster is recommended 

Systeemeisen 

BIMx mobile (smartphone)
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Supported devices: 
• iPad 2 

• iPad 3 or newer (recommended) 

• iPhone 4S 

• iPhone 5 or newer (recommended) 

• iPod Touch 5th generation 

• Android based devices running Android 4.0 or newer with Tegra3, Mali602, PowerVR SGX 543, Adreno 302 or faster GPU 

File size limitations on mobile devices 

* Largest 3D model that can be opened in the BIMx Hyper-model file. You can check the 3D Model Size when the 3D View is selected in the 
BIMx Model’s Menu. There is no file size limit for the overall Hyper-model but the upload to the BIMx Model Transfer Site is limited to 150 

MB/each component of a BIMx Hyper-model. 
** You can check the Geometry Size on the Info panel in BIMx Desktop Viewer.

Systeemeisen 

BIMx mobile (tablet)
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Sluit de achtergrond applicaties op het apparaat! 
Maak gebruik van het maximale geheugen van je apparaat. Andere applicaties gebruiken steeds een (minimaal) deel van het ingebouwd 
geheugen als ze open staan. Het kan zijn dat er bij het openen van grote modellen veel geheugen nodig is. Sluit daarom de achtergrond 

applicaties.  

Het gebruik van BIMx (PRO)  

Optimaal gebruik maken van de tablet en smartphone app.
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Orbit 
Ben je buiten het gebouw, gebruik dan 1 vinger om het model als geheel te draaien. (Veeg 1 vinger over het scherm om het gebouw te 
draaien) 

Turn in Place 
Ben je binnen in het gebouw, veeg met 1 vinger over het scherm om de camera te draaien. 

Pan 
Gebruik twee vingers om de pan-functie te gebruiken. (Veeg 2 vingers over het scherm om het gebouw te verplaatsen.) Je kan vrij door de 
wanden heen navigeren met de pan-functie. 

BIM Info 
BIM information (Element naam en ID, hoogte, afmeting, volume) van elementen kan weergegeven worden in de app.  
Zorg wel dat de BIM Info staat aangevinkt in de Settings binnen de BIMx app. 

Zoom 
Beweeg 2 vingers naar elkaar toe of van elkaar weg om respectievelijk in te zoomen en uit te zoomen. Je kan vrij door de wanden heen 
navigeren tijdens het zoomen. 

Fit in Window 
Klik op het huis-icoon (bovenaan rechts op het scherm) om het gebouw volledig in beeld te krijgen.  

Go to Location 
Klik op een oppervlakte (een rond icoon verschijnt), klik op het icoon en kies voor ‘Go to’. 

Navigeren in de BIMx (PRO) applicatie 

Gebruik van de app
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Wandel door een deur 
Klik op een deuropening zodat het icoon verschijnt.  
If you tap on a door, a running-man icon appears. Now tap this icon to walk through the door. 

Wandel in het gebouw 
Activeer de Wandelmodus rechts onder in het scherm, door op het mannetje te klikken.  
Door 1 vinger op het scherm te bewegen kan deze gebruikt worden als joystick om te wandelen. 

• Joystick omhoog om vooruit te wandelen. Hoe hoger, hoe sneller.  

• Joystick omlaag om achteruit te wandelen. Hoe lager, hoe sneller. 

• Joystick links/rechts om ter plekke te draaien. 
Gebruik een 2de vinger om te draaien terwijl er met de eerste vinger vooruit/achteruit gewandeld wordt. 
De wandelmodus werkt volgens de zwaartekracht.  

• Je moet op een vloer lopen 

• De enige manier om naar de verdieping te navigeren is door de trap te nemen. 

• De enige manier om naar een andere kamer te gaan is om door de deur te gaan via ‘go through’. 

Tip:  
Het is mogelijk om de joystick links op het scherm te laten verschijnen voor links handige gebruikers.  
iOS: Instellingen (van de tablet) > BIMx PRO > Joystick: Left-handed ON 
Android: Settings/ Navigation/ Joystick > Left-handed 

Fly Mode (vlieg modus) 
“Fly” modes betekend dat er geen zwaartekracht aan staat. Je kan ook door de wanden navigeren.  
Fly Modes is de standaard begin modus wanneer het totale gebouw zichtbaar is. 

Navigeren in de BIMx (PRO) applicatie 

Gebruik van de app
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Navigeren tussen 2D en 3D met behulp van de markers.  
Markers werken als koppelingen tussen verschillende vensters.  
Zowel onderling tussen de 2D layouts als in het 3D venster.  

Navigeren in de BIMx (PRO) applicatie 

Gebruik van de app
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Navigeren tussen 2D en 3D met behulp van de snelkoppeling.  
Vanuit een 2D layout kan er snel gekozen worden om het (huidige) beeld in 3D te openen door op het huisje links beneden te klikken. (1) 
Vanuit het 3D beeld kan de laats geopende layout terug worden geopend door op het layout icoon te klikken.  (2) 

Het is ook mogelijk om de laat geopende layout te tonen in het 3D beeld als een snijvlak. (3)

Navigeren in de BIMx (PRO) applicatie 

Gebruik van de app
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Snijvlakken gebruiken 
Bij het weergeven van een layout in 3D via deze knop              , wordt er OOK een snedevlak 
gecreëerd. De layout en het snedevlak kunnen elk apart geselecteerd worden en bewerkt worden.   

Layout bewerken  
• Verplaatsen: Klik op de layout om hem te selecteren, sleep dan aan de layout om hem te 

verleggen. (Enkel de layout verplaatst! De snede gaat niet mee) 

• Bewerken: Klik op de layout en klik nogmaals op het rond icoon.  
Kies voor Openen, het model hier doorsnijden, of de layout verbergen 

Tip:  
Cut here kan gebruikt worden na het verplaatsen van de layout.  

Snedevlak bewerken 
• Verplaatsen: Klik op het snedevlak om het te seleteren. Versleep het geselecteerde snedevlak 

om de snede te verleggen. (De snede wordt direct verplaatst naar de nieuwe locatie.)  

• Bewerken: Klik op het snedevlak en klik nogmaals op het rond icoon voor de opties.  
Kies voor Flip (de andere kant van het model wordt weggesneden), Uit, (Don’t )Cut objects.  
Bij deze laatste optie worden de objecten niet doorgesneden. 

Navigeren in de BIMx (PRO) applicatie 

Gebruik van de app
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Zones worden altijd mee geëxporteerd met het 3D model. Ook al stonden ze niet zichtbaar in het 3D model bij de export!  

Zones aanzetten in de app 
• Open een 3D beeld van het model 

• Ga naar de instellingen rechts bovenaan ( … )  

• Kies Settings 

• Maak de zones zichtbaar 

Bij het navigeren wordt nu de zone informatie links bovenaan getoond.  

Let op!  
Zones worden nooit doorgesneden door een snedevlak. 

Het gebruik van informatie tabs 

Zones zichtbaar maken
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Inloggen in een BIMcloud project 
Klik op de (i) achter bij de informatie van het project.  
Kies voor ‘join’ om in te loggen als een gebruiker.  

Annotaties maken 
• Kies voor de enveloppe om een aantekening te sturen 

• Bepaal wie de aantekening ontvangt 

• Voeg er een boodschap aan toe 

• Voeg er eventueel ook een afbeelding aan toe.  
Activeer dit door op de paperclip te klikken.  
Er kan nu gekozen worden voor een :  

• Schermafbeelding met annotaties 

• Het maken van een foto 

• Bladeren door de foto’s op de tablet 

• Kies voor ‘Send’ 

Selectie versturen 

• Klik op een element en kies voor select.  

• Links bovenaan verschijnt : ‘Selected : x’ 

• Klik hier op en kies voor ‘Send in message’

BIMcloud 

Toepassingen in BIMx PRO
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